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IRI Products

sortcl

sortcl is the executable used for CoSort, NextForm, FieldShield, DarkShield, 
and RowGen operations, which are all supported in the IRI Voracity data platform. 
Therefore, use the CoSort install procedure for all of these.

IRI Data Manager Suite

• CoSort uses sortcl to execute scripts that can be created in IRI Workbench. 
These scripts can filter, join, aggregate, and perform many more functions.

• NextForm uses sortcl to remap data, convert data types, and change the 
endianness of data in fields and columns. At the same time it facilitates file, 
database, and platform migrations.

• RowGen uses sortcl to execute scripts that can create fake data that emulates 
real data. These scripts can be created in IRI Workbench. 

• FACT is used to extract large database tables to flat files using SQL queries that 
can be done using parallelism.

IRI Data Protector Suite

• FieldShield uses the sortcl executable and IRI Workbench to locate, 
categorize, risk-score, and de-identify sensitive data such as PII. 

• DarkShield relies on sortcl for licensing, but uses a Java RPC API that is called 
programmatically from the command line, or from IRI Workbench. It is used to 
discover, extract, mask and report on sensitive data in structured, semi-
structured, and unstructured sources. 

• CellShield EE is an add-in product for Excel that finds, reports on, and masks 
PII and is used in conjunction with IRI Workbench.

IRI Workbench

IRI Workbench is an Eclipse IDE used to discover data, and to design and 
manage sortcl-compatible jobs for the components of the Data Manager and Data 
Protector products.

NextForm Special Versions

To install these, see the instructions at www.iri.com/nextform. 

Lite Includes the NextForm executable. 
COBOL Includes Lite and Micro Focus libraries.
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Minimum System Requirements

The minimum requirements to run any IRI software using sortcl is as follows:

• 40MB RAM but can require up to 4GB with IRI Workbench. This is especially 
true for FieldShield and DarkShield users when enumerating tables and 
annotations. 

• 150MHz CPU speed

• Hard drive space should allow for at least 3X the size of the largest input file 
that will be accessed at any given time. It needs 1X for the input file(s), 1X for 
the temporary files that are generated at runtime, and 1X for the output file(s)

• CoSort supports several processor architectures, including:

• Alpha EV4-6
• IBM POWER3-8
• MIPS
• PA-RISC1.1-2.0w
• SPARC
• UltraSPARC
• ia64
• ppc and ppc64
• s390 and s390x for zlinux
• x86 and x86-64

For a complete, up-to-date list of supported platforms and processor architectures, 
visit www.iri.com, or refer to the Compatible Platforms section in the Introduction 
chapter of the CoSort User Manual & Programmer’s Guide.

Platforms Supported

Platforms compatible with IRI software products include:

• AIX 5.1 and above on IBM Power architecture

• HP-UX 11.0 and above on the Intel Itanium architecture

• Linux kernel 2.6 and above on Intel x86 & x64 and ARMv6 

• Linux kernel 2.6 and above on ARMv6 and above architecture

• Solaris 5.8 and above on Sun Sparc architecture

• Solaris 10 on Intel x64 architecture

• Windows 7 and above on Intel x86 & x64 architecture

• Windows Server 2003 and above on Intel x86 & x64 architecture

http:\\www.iri.com
http:\\www.iri.com
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Installing CoSort on Unix and Linux Operating Systems

The installation of sortcl is required if you purchased products that include CoSort, 
FieldShield, RowGen, or NextForm.

Refer to Platforms on page 23 for more operating system-specific configuration 
instructions.

If upgrading, it is not necessary or advisable to remove your existing version. To test 
a new CoSort version on the same system, modify the value of $COSORT_HOME to 
the installation path of the version you want to run.

Loading

1. Obtain the files cosort-installer.sh and CoSort110x.platform.tar.gz from 
your IRI representative.

2. In binary mode, move these files to the machine on which the CoSort product will 
be licensed.

3. Enter: sh cosort-installer.sh CoSort105x.platform.tar.gz

Installation and Registration

Answer all the following prompts:

Specify COSORT_HOME. This is the directory for the CoSort 
software:

Enter the full path name that will contain the CoSort installation directory and 
subdirectories, or press Enter to accept the default cosort110 that is shown in 
the prompt.

Would you like to view the Release Notes (readme) now? (y/n)

If installing this version of CoSort for the first time, select y to view the readme 
file for known issues. Details on product changes and enhancements since the 
prior version are included. Scroll through the file by pressing any key.

Otherwise, select n to continue.

Would you like to run "bin/cs_setup" now ? (y/n)

You must run cs_setup in order to register, license, and tune sortcl. If you 
choose not to run cs_setup at this time, select n. You are instructed on how to 
run cs_setup in the future when you are ready.

To run cs_setup, enter y.
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Running Setup from the Command Line

cs_setup is located in the $COSORT_HOME/bin directory. After executing 
cs_setup, the CoSort Setup screen opens with the following options available:

1.First Time Setup

2.Update License

3.Tune CoSort

4.Exit

1. Select First Time Setup. Complete all of the relevant fields in the CoSort 
Customer Registration Form. This form is required to obtain license keys. Do not 
use a Customer Registration Form that was created on another computer! This 
will result with you receiving invalid license keys.

Upon completion, a RegForm.txt file will appear in the installation/bin directory 
($COSORT_HOME/bin) that you specified earlier. E-mail the 
$COSORT_HOME/bin/RegForm.txt and $COSORT_HOME/etc/cosort.rc to 
licenses@iri.com. Note that you can edit this form with a text editor after the 
setup process is complete. 

2. After pressing enter for the last item in the RegForm, a menu of resource control 
(RC) options displays. These are:

1. THREAD_MAX
This sets the total number of cores (Number of CPUs X Cores per CPU) that 
were entered in the RegForm. Typically this is set to the number of THREADS 
that are purchased with your license. A higher setting will result in a license 
violation error at runtime.

2. THREAD_MIN
This sets the minimum number of threads for running a job. The default is 1.

3. MEMORY_MAX
This sets the upper memory limit used for in-memory sorts before data 
overflows to disk-based temporary files. Default is AUTO. This provides the 
best performance when running a single instance of sortcl. MINIMIZE 
provides the best performance when running multiple instances of sortcl jobs 
simultaneously. You can also set this to a literal value or percentage of RAM.

4. WORK_AREAS
Specify the directories where temporary files are written. You can specify 
multiple directories one at a time. The default is ./. This is the current 
directory from where a job is started.

For Unix and Linux users, if your sort input, temporary, or output files will be 
read from or written to remote, NFS-mounted drives, then you should add 
the following entry to the cosort.rc file:
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AIO OFF
to disable use of AIO (Asynchronous Input/Output) by CoSort. By default, 
AIO ON is set.

5. BLOCKSIZE
This defines the size of the sort buffers. When MEMORY_MAX is set to AUTO 
or MINIMIZE, the BLOCKSIZE is set automatically; otherwise, the default for 
UNIX is 1200KB and for Windows is 2048KB. When setting for a specific job, it 
is best set to a little more than a multiple of the expected input record size.

6. MONITOR_LEVEL
The monitor level specifies the degree of detail for reporting sent to stderr  
when running a CoSort job. The setting can be from 0 to 9. With 
MONITOR_LEVEL 0, there is no monitoring. Each level gives progressively 
more information, like the opening and closing of files. Levels 3-9 give the 
number of processed records with 3 reporting every 1,000,000 and 9 
reporting every record. The default MONITOR_LEVEL is 0. 

7. MINIMUM_YEAR
This is used by CoSort jobs to set a sliding century window with two data 
types for specifying a minimum century year for the handling of pre-year 
2000 data. The relevant CoSort data types are CS_Y2K_ASCII_JULIAN 
and CS_Y2K_ASCII_YR. The default setting is 70.

8. ON_EMPTY_INPUT
This setting determines the disposition of sortcl targets when all data 
sources are empty (that is, when they exist but contain 0 bytes). The options 
do not apply to piped input or input procedures, or when any single input 
file in a multi-source list contains records. The following four options are 
supported:

PROCESS_WITH_ZEROS
The default. Output data is created assuming zero-value input data. 
The output will not be empty. It may contain zero values for summary 
columns and other requested sortcl formatting data.

EMPTY_OUTPUT
An empty output target with zero bytes is created.

UNCHANGE_OUTPUT
If an output file of the same name already exists prior to sortcl 
processing of empty input, the original target is unchanged.

DELETE_OUTPUT
If a target of the same name already exists prior to sortcl processing 
of empty input, the original output file will be deleted. No new output 
file will be created.
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9. OUTPUT_TERMINATOR
Determines the record terminator used when output is specified as variable-
length with /PROCESS=RECORD. The following options are supported:

3. Change individual RC values by selecting the corresponding menu number to 
enter new values. Any changes will be applied to the cosort.rc file. See Resource 
Control Settings in your CoSort user manual for details, and see Platforms on 
page 23 for information pertaining to your particular version of Unix/Linux. Values 
are stored by default in $COSORT_HOME/etc/cosort.rc.

4. To save your changes and continue, press 0. The following displays: 

Save the Resource Control Settings to 
[/install_dir/cosort110/etc/cosort.rc]: ?

5. The cosort.rc file is based on the above responses and is stored in the directory 
$COSORT_HOME/etc, which, by default, is used for all jobs run with CoSort 
compatible user interfaces and APIs. However, you can store one or more 
cosort.rc files elsewhere on your system for special job requirements, as 
described in "Using Customized Resource Control Files" in Appendix D of the 
CoSort user manual. That section describes all cosort.rc settings. You can use 
any text editor or IRI Workbench to add or modify settings.

6. Press Enter to accept the default location and file name. If you want to save to a 
different location or file name, type the full path and name that is desired, then 
press Enter. The cosort.rc file and the RegForm.txt file will be saved to the 
indicated locations. The RegForm.txt needs to be sent to licenses@iri.com so that 
your license keys can be generated and sent to you.

7. Be sure to set the $COSORT_HOME environment variable according to the on-
screen instructions. This is required to run any CoSort tool.

INFILE
The default behavior. When input is variable-length, this option uses 
the same terminator as the input file; that is, either a linefeed (LF) or 
a carriage-return-linefeed (CRLF). Typical termination for variable 
length records for a Linix  or UNIX operating system a linefeed (LF). It 
is equivalent to \n. Use the DOS option (see below) if you prefer 
CRLF.

DOS
Typical termination for variable length records for a DOS or Windows 
operating system. It is equivalent to \r\n, that is, a carriage-return-
linefeed (CRLF).

Unix
Typical termination for variable length records on a Linux or Unix 
operating system. It is equal to \n, that is, a linefeed.

character
The character, or character string, that you specify — possibly the 
null string "" — is appended to each output record.
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8. Press Enter to end the setup program.

9. Repeat all the previous steps for any other licensed machines where you want to 
do an installation.

License Key Activation

1. When license keys are received, run cs_setup from the $COSORT_HOME/bin 
directory by entering: ./cs_setup

2. Select the Update License option. The CoSort License Entry dialog opens.

3. Enter in order, the three license key values provided by IRI, then click OK.

4. Select Exit.

The license can be updated the license even if a job is in progress. The new 
keys will be used in the next job so long as the executable is in the same 
$COSORT_HOME environment.

Re-Tuning

Your IRI representative may provide you with alternative recommendations for your 
cosort.rc settings. Contact support@iri.com or call your IRI representative for 
assistance. 

Run $COSORT_HOME/bin/cs_setup and select Tune CoSort to modify your 
default resource settings. You can also use a text editor to add or modify settings in 
the cosort.rc file. Appendix D of the CoSort manual describes all settings for the 
cosort.rc file. 

NOTE
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Installing Workbench on Linux and Unix

Workbench for Linux and Unix is shipped as a tar.gz file. IRI recommends unpacking 
the contents into a folder named workbench2, located in the parent of the 
$COSORT_HOME directory. However, this is not a requirement. 

The unpacked files will contain the iri-workbench executable file

Unpack on Linux with the GNU tar command:

tar -xvzf com.iri.pelican.workbench-linux.gtk.x86_64.tar.gz

On Unix where there is no GNU tar command, use the following command:

gunzip -c com.iri.pelican.workbench-linux.gtk.x86_64.tar.gz | tar -xvf -

Run the executable to open IRI Workbench. Check for updates from the Help menu.
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Installing CoSort and IRI Workbench on Windows

The installation of sortcl is required if you purchased products that include Voracity, 
CoSort, FieldShield, RowGen, DarkShield, or NextForm.

Download the installation program for Windows from the URL provided by your IRI 
representative.

When upgrading, it is not necessary or advisable to remove the existing 
version. To test a new CoSort version on the same system, modify the 
value of %COSORT_HOME% to the installation path for the version you 
want to install.

Installing sortcl or Voracity on Windows operating systems:

Loading

1. Run the installation program. The InstallShield Wizard prepares the setup. A 
splash screen displays when the setup is ready to start.

NOTE
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When the Welcome screen displays, click Next to continue.

2. The Software License Agreement screen opens. Read the license agreement. If 
you accept the terms, select the option I accept the terms in the license 
agreement. (You can choose to print the license agreement.) Then click Next.

3. The Customer Information screen then displays. Fill in User Name and 
Organization, then click Next.

4. Now select the Setup Type. By default, the Complete setup will install the 
CoSort command line tools plus IRI Workbench in C:\IRI. If you opted for 
Darksheield, that program will also be installed. Select Custom to choose the 
features to be installed or to choose a different directory for the install. For most 
people, Complete should be selected, then click Next.

5. On the next screen, click this button to begin the installation:
A screen with a progress bar will display during the 
installation.
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6. This screen will display during the installation
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7. When the installation is complete, click Finish.  

8. The %COSORT_HOME% environment variable has been set to the directory 
install_dir. In addition, the PATH for the executable of the IRI tool 
(install_dir\cosort110\bin) has been added to the environment variable 
%PATH%. If the full install was chosen, then the IRI Workbench icon is now on 
your desktop. 
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9. To run the 64bit version of CoSort, Microsoft C++ needs to be present. The 
following screen will display if it needs to be installed:
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Running Setup from IRI Workbench

1. To perform the setup from IRI Workbench, double-click on that icon on your 
desktop. You are asked for a path for the workspace directory. This is the 
directory where items created in IRI Workbench are saved. Accept the default 
workspace or browse to select a different one.

2. The Welcome screen displays. Select First Steps, then select Registration.

3. If the Welcome screen does not display and you are taken directly into 
Workbench. Select Help from the Menu bar, and then IRI Registration. 

4. Either of the two previous steps will bring up the Product Information page. 
The Serial Number on this page should be empty or have zeros and X’s. If it has 
something else, then you have a COSORT_HOME environment variable set for a 
different CoSort installation and you need to unset that environment variable 
before continuing. 
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5. Enter the serial number that was emailed to you, then select Next.

6. Fill out the items on the Company Information page, then select Next.
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7. On the Hardware Information page, some of the items have been filled in for 
you. Complete any remaining items, then select Finish. 

8. The information on the two preceding pages is recorded in the file named 
RegForm.txt. After Finish is selected, a popup will give the path with the name 
for the RegForm.txt file. E-mail this file to licenses@iri.com. The license keys 
that are required to activate your IRI product can then be emailed to the email 
address indicated in the form. Select Finish.

9. Go to the below section, Running Setup from the Command Line, to set 
resource control options. This is done by selecting the option to Tune Cosort. 
You can accept the default values or change those values

Running Setup from the Command Line

From a command prompt, change to the directory \install_dir\cosort110\bin.

Enter cs_setup. The CoSort Setup screen opens as below:

---------------------------------------
  CoSort 11.0.1 Setup
---------------------------------------

Enter the number of one of the following options:

1. First Time Setup

2. Update License

3. Tune CoSort

4. Exit

If you have not completed a RegForm.txt file, select First Time Setup. Complete 
all of the relevant fields in the CoSort Customer Registration Form. This form is 
required to obtain license keys. Do not use a Customer Registration Form that 
was created on another computer! 

Once the Registration form is filled out, you are in the area for the Cosort Tuning 
Info. This is where you can set the default values for some of the items in the CoSort 
Resource Control File. The values that are set here affect the performance of the 
CoSort jobs. Here are the values that can be set now. You can accept the default 
values, or change any values by selecting the number for that value..
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Here are the current settings:

         1. THREAD_MAX         8 (This should be set to the number processors 
                                              that you purchase)

         2. THREAD_MIN         1

         3. MEMORY_MAX         AUTO

         4. WORK_AREAS         .\

         5. BLOCKSIZE

          6. MONITOR_LEVEL      0

          7. MINIMUM_YEAR       70

          8. ON_EMPTY_INPUT     PROCESS_WITH_ZEROS

          9. OUTPUT_TERMINATOR  INFILE

Here are explanations of the items:

1. THREAD_MAX
This sets the total number of cores (Number of CPUs X Cores per CPU) that you 
entered in the RegForm. Typically, this is set to the number of THREADS that are 
purchased for your license. A higher setting will result in a license violation error 
at runtime

2. THREAD_MIN
This sets the minimum number of threads for running a job. The default is 1.

3. MEMORY_MAX
This sets the upper memory limit used for in-memory sorts before data overflows 
to disk-based temporary files. Default is AUTO. AUTO provides the best 
performance when running a single instance of sortcl. MINIMIZE provides the 
best performance when running multiple instances of sortcl jobs simultaneously. 
You can also set this to a literal value or to a percentage of RAM.

4. WORK_AREAS
Specify the directories where temporary files are written. You can specify multiple 
directories one at a time. The default is ./, which is the directory where a job is 
started.

For Unix and Linux users, if your input, temporary, or output files for a sort will be 
read from or written to remote, NFS-mounted drives, then you should add the 
following entry to the cosort.rc file:

AIO  OFF

This disables the use of Asynchronous Input or Output by CoSort.
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5. BLOCKSIZE
This defines the size of the sort buffers. When MEMORY_MAX is set to AUTO or 
MINIMIZE, the BLOCKSIZE is set automatically; otherwise, the default for UNIX is 
1200KB and for Windows is 2048KB.

6. MONITOR_LEVEL
The monitor level specifies the degree of detail for reporting that is sent to stderr 
when running a CoSort job. The setting can be from 0 to 9. With 
MONITOR_LEVEL 0, there is no monitoring. Each level gives progressively more 
information, such as the opening and closing of files. Levels 3-9 give the number 
of processed records with 3 reporting every 1,000,000 and 9 reporting every 
record. The default MONITOR_LEVEL is 1.

7. MINIMUM_YEAR
This is used by CoSort jobs to set a sliding century window for the data types 
CS_Y2K_ASCII_JULIAN and CS_Y2K_ASCII_YR. It specifies a minimum 
century year for the handling of pre-year 2000 data.  The default setting is 70.

8. ON_EMPTY_INPUT
This setting determines the disposition of sortcl targets when all data sources are 
empty (that is, when they exist but contain 0 bytes). The options do not apply to 
piped input or input procedures, or when any single input file of a multi-
source list contains records. The following four options are supported:

9. OUTPUT_TERMINATOR
Determines the record terminator used when output is specified as variable-
length with /PROCESS=RECORD. The following options are supported:

PROCESS_WITH_ZEROS
The default. Output data is created assuming zero-value input data. 
The output will not be empty. It may contain zero values for summary 
columns and other requested sortcl formatting data.

EMPTY_OUTPUT
An empty output target (with zero bytes) is created.

UNCHANGE_OUTPUT
If an output file of the same name already exists prior to sortcl 
processing of empty input, the original target is unchanged.

DELETE_OUTPUT
If a target of the same name already exists prior to sortcl processing 
of empty input, the original output file will be deleted. No new output 
file will be created.

INFILE
The default behavior. When input is variable-length, this option uses 
the same terminator as the input file; that is, either a linefeed (LF) or 
a carriage-return-linefeed (CRLF). For fixed-length input, the default 
output terminator is LF. Therefore, use the DOS option (see below) if 
you prefer CRLF.

DOS
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Enter an option number to modify, or 0 to save and continue

Once the cosort.rc file is saved, the following screens displays. This is the same 
screen that displays when you select "Governance Setup" from the main menu.

This has created the file RegForm.txt which can be found in the directory 
%COSORT_HOME%\etc

To request a license key, please email the file or contents to licenses@iri.com. 
Be sure the email address in the form is correct to receive the key.

Press Enter to continue. This will take you back to the main menu. Press 5 to Exit.

Now you can email the request for license keys.

When you receive your license keys from IRI, run %COSORT_HOME%\bin\cs_setup
again and select '2.  Update License' from the menu. You will be asked to enter each 
of the keys.

If you previously completed the RegForm.txt file, select Tune CoSort, where you 
can set values for nine of the resource control (RC) options by skipping to item 7 in 
this section.

10.Upon completion, a RegForm.txt file will appear in the install_dir\bin directory 
%COSORT_HOME%\bin) that you specified earlier. E-mail the combined 
%COSORT_HOME%\bin\RegForm.txt and 
%COSORT_HOME%etc\cosort.rc to licenses@iri.com. Note that you can edit 
this form with a text editor, if necessary, after the setup process is complete. 

11.After pressing enter for the last item in the RegForm, a menu of eleven resource
control (RC) options displays.

12.The RC options are:

1. THREAD_MAX
This sets the total number of cores (Number of CPUs X Cores per CPU) that 

Typical termination for variable length records for a DOS or Windows 
operating system. It is equal to \r\n, that is, a carriage-return-line-
feed.

Unix
Typical termination for variable length records on a Linux or Unix 
operating system. It is equal to \n, that is, a linefeed.

character
The character, or character string, that you specify — possibly the 
null string "" — is appended to each output record.
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you entered in the RegForm. Typically, this is set to the number of THREADS 
that are purchased for your license. A higher setting will result in a license 
violation error at runtime.

2. THREAD_MIN
This sets the minimum number of threads for running a job. The default is 1.

3. MEMORY_MAX
This sets the upper memory limit used for in-memory sorts before data 
overflows to disk-based temporary files. Default is AUTO. AUTO provides the 
best performance when running a single instance of sortcl. MINIMIZE 
provides the best performance when running multiple instances of sortcl jobs 
simultaneously. You can also set this to a literal value or to a percentage of 
RAM.

4. WORK_AREAS
Specify the directories where temporary files are written. You can specify 
multiple directories one at a time. The default is ./, which is the directory  
where a job is started.

For Unix and Linux users, if your input, temporary, or output files for a sort 
will be read from or written to remote, NFS-mounted drives, then you should 
add the following entry to the cosort.rc file:

5. AIO OFF
to disable use of AIO (Asynchronous Input/Output) by sortcl. By default, AIO 
ON is set. 

6. BLOCKSIZE
This defines the size of the sort buffers. When MEMORY_MAX is set to AUTO 
or MINIMIZE, the BLOCKSIZE is set automatically; otherwise, the default for 
UNIX is 1200KB and for Windows is 2048KB.

7. MONITOR_LEVEL
The monitor level specifies the degree of detail for reporting that is sent to 
stderr when running a CoSort job. The setting can be from 0 to 9. With 
MONITOR_LEVEL 0, there is no monitoring. Each level gives progressively 
more information, such as the opening and closing of files. Levels 3-9 give 
the number of processed records with 3 reporting every 1,000,000 and 9 
reporting every record. The default MONITOR_LEVEL is 0. 

8. MINIMUM_YEAR
This is used by CoSort jobs to set a sliding century window with two data 
types. This specifies a minimum century year for the handling of pre-year 
2000 data. The relevant CoSort data types are CS_Y2K_ASCII_JULIAN 
and CS_Y2K_ASCII_YR. The default setting is 70.

9.ON_EMPTY_INPUT
This setting determines the disposition of sortcl targets when all data 
sources are empty (that is, when they exist but contain 0 bytes). The options 
do not apply to piped input or input procedures, or when any single input 
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file of a multi-source list contains records. The following four options are 
supported:

10. OUTPUT_TERMINATOR
Determines the record terminator used when output is specified as variable-
length with /PROCESS=RECORD. The following options are supported:

8. Change individual RC values by selecting the corresponding menu number. Any 
changes will be applied to the cosort.rc file. See Resource Control Settings in 
your CoSort user manual for details. Values are stored by default in 
%COSORT_HOME%\etc\cosort.rc.

9. To save your changes and continue, enter 0. The following displays: 

Save the Resource Control Settings to 
[\install_dir\cosort105\etc\cosort.rc]: ?

PROCESS_WITH_ZEROS
The default. Output data is created assuming zero-value input data. 
The output will not be empty. It may contain zero values for summary 
columns and other requested sortcl formatting data.

EMPTY_OUTPUT
An empty output target (with zero bytes) is created.

UNCHANGE_OUTPUT
If an output file of the same name already exists prior to sortcl 
processing of empty input, the original target is unchanged.

DELETE_OUTPUT
If a target of the same name already exists prior to sortcl processing 
of empty input, the original output file will be deleted. No new output 
file will be created.

INFILE
The default behavior. When input is variable-length, this option uses 
the same terminator as the input file; that is, either a linefeed (LF) or 
a carriage-return-linefeed (CRLF). For fixed-length input, the default 
output terminator is LF. Therefore, use the DOS option (see below) if 
you prefer CRLF.

DOS
Typical termination for variable length records for a DOS or Windows 
operating system. It is equal to \r\n, that is, a carriage-return-line-
feed.

Unix
Typical termination for variable length records on a Linux or Unix 
operating system. It is equal to \n, that is, a linefeed.

character
The character, or character string, that you specify — possibly the 
null string "" — is appended to each output record.
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10.The cosort.rc file contains the settings from your above responses and is stored 
in the directory %COSORT_HOME%\etc, which, by default, is used for all jobs 
run with CoSort compatible user interfaces and APIs. However, you can make 
and use one or more cosort.rc files elsewhere on your system for special job 
requirements, as described in "Using Customized Resource Control Files" in 
Appendix D of the CoSort user manual. That section describes all possible 
cosort.rc file settings. You can use IRI Workbench or any text editor to add or 
modify settings.

11.Press Enter to accept the default location and file name. If you want to save to a 
different location or file name, type the full path and name that you want, then 
press Enter. The cosort.rc file and the RegForm.txt file have been saved to the 
indicated locations. The RegForm.txt and the cosort.rc files need to be sent to 
licenses@iri.com so that your license keys can be generated and sent to you.

12.Enter 5 to exit the setup program.

Activating Your License Using Workbench

1. After you receive your three license keys, start IRI Workbench.

2. You can select First Steps from the Welcome screen or select IRI License from 
Help on the menu bar. This returns you to the License Key page.

3. Type in each of the license keys, then select Finish. The license for your IRI tool 
is now active. To verify that your license is active, select Version Information 
from the Help menu. On that screen, you will see something similar to the 
following which displays the version, serial number, and expiration date:

CoSort 10.5.1 R105240201-1825 x86_32 Copyright 1978,2024 IRI, Inc. www.iri.co
2024-02-10 13:36:13 #99999.test 6 CPU
Expiration Date: non-expiring

4. If your keys are not working, you will see something similar to below. 

CoSort 10.5.1 R105240201-1825 x86_64 Copyright 1978,2024 IRI, Inc. www.iri.com
2024-02-10 13:51:33 #99999.test 0 CPU
Monitor Level: 1
   <00:00:00.00> error (46): 99999.test license violation: 
   incorrect node or invalid key

Check your write permission for the file %COSORT_HOME%\etc\cosort.lic. 
Once you have permission to edit the file cosort.lic, you should manually edit 
that file to insert the three key values, then verify that the keys are working. If 
there is still a problem, then contact your IRI agent.

Activating Your License from the Command Line

1. Once you receive your license keys, at the command prompt, change to the 
directory \install_dir\cosort105\bin

2. Enter cs_setup. The CoSort Setup screen opens with the following options:
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• First Time Setup
• Update License
• Tune CoSort
• Exit

3. Select Update License.

4. Type in each of the three keys. Press enter after each is entered. 

5. You will then see the following line:

The license file has been updated successfully.
Press the Enter key to continue...

This will return you to the main menu.

6. Select Exit to close the CoSort Setup screen. 

The following is then displayed:

You may add $COSORT_HOME/bin to your
PATH, and $COSORT_HOME/lib to your
LD_LIBRARY_PATH.

Make sure that the permissions for the
executables in $COSORT_HOME/bin
are set correctly for all users.

Governance controls such as sortcl job
permissions, auditing, and log retention
policies can only be changed by a member of
the cs_governor group, which must be established
with one or more members on the operating system.

Type sortcl /v  from the install_dir\bin directory to verify that your keys are 
working. There should be a message similar to:
CoSort 11.0.1 R110260227-1825 x86_64 Copyright 1978,2024 IRI, Inc. www.iri.com
2024-03-18 15:05:52 #99999.TEST 6 CPU
Expiration Date: non-expiring

7. If your keys are not working, you will see something similar to below. 

CoSort 11.0.1 R110260227-1825 x86_64 Copyright 1978,2024 IRI, Inc. www.iri.com
2024-03-10 13:51:33 #99999.test 0 CPU
Monitor Level: 0
   <00:00:00.00> error (46): 99999.test license violation: 
   incorrect node or invalid key

Check your write permission for the file %COSORT_HOME%\etc\cosort.lic. 
Once you have permission to edit the file cosort.lic, you should manually edit 
that file to insert the three key values, then verify that the keys are working. If 
there is still a problem, then contact your IRI agent.
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The license can be updated even if a job is in progress. The new keys will 
be used in the next job so long as the executable is in the same 
%COSORT_HOME% environment.

NOTE



1  The IRI Workbench Version of DarkShield

Installation Guide 25 Installing DarkShield RPG

Installing DarkShield

DarkShield can be installed either as a backend API engine, or with an installation of the 
IRI Workbench (GUI). It can be a standalone product or bundled in the IRI Voracity data 
management platform.

sortcl is the executable for the IRI CoSort engine. The installation process for CoSort 
must be done to enable sortcl to execute masking jobs.

To run any jobs, you must first start the DarkShield server via one of the following:

1. Shell or batch startup script in the DarkShield API distribution bin directory

2. Workbench Window > Preferences > IRI > DarkShield properties dialog

3. DarkShield API Status view in your workspace

1 The IRI Workbench Version of DarkShield

DarkShield is installed as part of the IRI Workbench installation.

DarkShield appears on the tool bar.

Open the DarkShield API configuration dialog in Preferences under the Window 
menu, then enter the local or remote folder location of the DarkShield API 
distribution in the box for Specify folder location of a Darkshield API 
distribution (e.g., C:\IRI\DarkShield\API\plankton-1.5.1). 

Click the Start Server button, then Apply and Close. Startup messages for the API 
server should appear in the Workbench console window confirming that the 
DarkShield API is configured correctly for use and management in Workbench.

2 Installing DarkShield for Remote Procedure Calls

2.1 Installation

The DarkShield RPC, also know as Plankton, is a web services platform for IRI API 
services. IRI Plankton provides services through a plugin interface, allowing the user 
to choose the needed functionality by installing the appropriate plugins. 

The operating system can be Linux or Windows, either on a local system or in a 
cloud, including within a container.
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The below dependencies must be installed prior to installing the Plankton API on the 
system.

• CoSort 10+
• Java JRE 11+
• Python 3.5+

This is required for the DarkShield plugin. These dependencies are compiled at 
startup using pip.

The full Plankton API can be downloaded, or the API can be downloaded without the  
API files. The .zip or .tar file for the Plankton API can be extracted in any directory 
creating the following file structure:

+-- bin
+-- plankton
+-- plankton.bat

*-- conf
+-- config.json
+-- log4j2.xml

+-- docs
+-- license_dependency.html
+-- license_dependency.json
+-- license_dependency.xml

+-- lib
+--  {plugin}-{version}.jar

+-- static
+-- docs

+-- LICENSE

2.2 Execution

To start the API, execute the file plankton on Unix or the file plankton.bat on 
Windows. These are located in the bin directory. To learn more about the various 
command line parameters, the commands can be executed with the -help flag. 

Once the server has started, the OpenAPI documentation for the API can be opened 
in the browser in the docs path of the server address. All information regarding the 
different endpoints and payload structures for the different plugins are documented 
there. If a web browser is not available, the different OpenAPI documents can also be 
downloaded from the /docs/{plugin}.yaml endpoints

2.3 Configuring Logging

The Plankton API uses slf4j with a Log4j2 implementation for logging purposes. The 
logging options can be edited in conf/log4j2.xml. The default configuration disables 
all logging information from non-plankton components and outputs the results to 
standard out.
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For faster throughput, DarkShield uses asynchronous logging provided by default 
through Log4j2. To disable asynchronous logging for resource constrained 
environments, remove the following option from either the bin/plankton or 
bin/plantkon.bat scripts:

Dlog4j.contextSelector=org.apache.logging.log4j.core.async.
AsyncLoggerContextSelector

The Log4j2 backend can be changed for another slf4j compatible implementation by 
replacing the log4j2 jars with the new implementation jars in the lib directory. A full 
list of these is available from https://logging.apache.org/log4j/2.x/manual/
appenders.html.

2.4 Configuring Start

By default, the Plankton server will launch on http://localhost:8959/. This can be 
modified in the conf/config.json file by editing the host and port parameters.            

To expose the API to the network, the host parameter can be set to the IP Address or 
host name of the network interface that the server uses to interact with the network. 
Another possibility is to use a reverse proxy server like Apache or NGINX to route 
requests to a locally hosted Plankton API. The reverse proxy approach is 
recommended for including additional functionality like load balancing or user 
authentication, since these concerns are not handled by the API

2.5 Configuring SSL

The DarkShield server can be started with SSL options enabled by adding an ssl 
object to the conf/config.json file: 

"ssl": {
   "certPaths": ["path/to/certificate.pem"],
   "keyPaths": [“path/to/key.pem"]

}

• certPaths is a list of paths to the certificate files.
• keyPaths is a list of paths to the private key files.

2.6 Configuring a Remote SSH CoSort Server

The Plankton API can be configured to operate with a CoSort installation which is 
hosted on a different server. Note that this approach is NOT recommended for 
production environments where latency is an issue.
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To configure a remote sortcl, enter the following information in the 
conf/config.json file:

"cosort": {
"ssh": {

"username": "required",
"host": "required",
"port 22",
"password": null,
"passphrase": null

}
     }

• username is the username for the ssh connection
• host is the host ssh server
• port is the ssh port on the remote server. This defaults to port 22.
• password is used if the connection should be authenticated using a password 

instead of a public key. It can be excluded if no password is necessary.
• passphrase is used to access an encrypted private key. It can be excluded if 

no passphrase is necessary.

2.7 Configuring a Different OpenAPI View

By default, Plankton renders the OpenAPI documentation using Swagger-UI. 
However, other implementations may be used by replacing the static/docs/
index.html file with an index.html file from a different implementation, like Redoc.

The OpenAPI documentation files can be found under the static/docs/openapi 
folder. The folder also contains an extensions.json file which contains a mapping 
between the plugin name and the specific OpenAPI documentation file for that plugin.
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Getting Started with IRI Workbench

IRI Workbench is a Graphical User Interface (GUI) and Integrated Development 
Environment (IDE) for all IRI software products. IRI Workbench is built on 
Eclipse™. 

IRI Workbench installs either standalone or as part of the full product installation 
for IRI products on Windows. Ask your IRI representative if you need a Linux 
version.

The workbench directory is located within the base product installation directory. 

If you did not perform a full product installation, install IRI Workbench from the zip 
file provided by your IRI representative.

Installing IRI Workbench from a .zip File

To install:

1. Download the IRI Workbench installation zip file from the link provided by your  
IRI representative and copy it to the target Windows computer.

2. Unzip the file into the directory where the files will reside; c:\IRI is advised.

3. Create a desktop shortcut using the icon for the iri-workbench.exe file.

4. Run iri-workbench.exe. The Select a Workspace screen opens. The 
workspace location defaults to the directory from where you ran the executable. 

A directory named workbench is created that will contain your workspace. Give 
workspace a unique name.

The Welcome to IRI Workbench screen opens.

If you install the IRI Workbench from its standalone zip file, you will need 
to manually create the start menu and desktop shortcuts. These are setup 
automatically in a full product installation.

Check for updates:

To run the latest IRI Workbench, check for updates online.

1. Click Help on the menu bar.

2. Select Check for updates.

NOTE

http://www.iri.com/products/workbench
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This pop-up will display while the check is executed:

3. When the check is complete, the following screen displays:

There will be a check mark next to the items that have updates available. Click 
Next, then select "I accept the terms of the license agreements", and click 
Finish.
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4. Once the update has completed, the following pop-up displays:

Click Yes to restart IRI Workbench.

5. It is possible that your IRI Workbench is not set up to get updates. If this is the 
case, then you will see the below dialog. Answer Yes.

This will take you to a dialog that looks similar to the following one. Click on the 
checkboxes for IRI Tools and IRI Workbench. Then click Apply and Close.
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You can also reach this dialog by selecting Window from the menu bar -> 
Preferences -> double-click Install/Update -> Available Software Sites

6. There are certain features that may not be present initially in your IRI Workbench 
such as New Re-ID Risk Scoring on the FieldShield menu. For this feature, 
the IRI Risk Scorer plugin is needed.
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To add any features, select Help from the menu bar -> Install New Software. 
A screen similar to the following displays when the Work with dropdown is 
exposed:

7. Select IRI Data Tools from the dropdown.

8. If IRI Data Tools is not listed, then click "Available Software Sites" and select 
IRI Data Tools so that it is added to the Work with dropdown, then select it 
from the dropdown.

9. IRI Data Tools now appears in the box under Name. Expand to see the features 
available for installation. Select the ones that you want installed and click Next 
and Next again.

10.Select "I accept the terms of the license agreements", and click Finish.
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Welcome to IRI Workbench

The Welcome screen, shown at startup or available from the Help navigation bar, 
links to resources that help you become familiar with the purpose and functions of 
IRI Workbench, and that prepare you to use the many tools available through this 
interface.

While on the Welcome screen, from the top navigation toolbar select Help --> Help 
Contents. Here the following topics can be selected: 

• IRI Workbench Tools User Guide
• Java development user guide
• Plug-in Development Environment Guide
• Data Tools Platform User Documentation
• Egit Documentation
• IRI Ripcurrent User Guide
• IRI Scheduler
• IRI Workbench Tools User Guides - This gives access to the user 

guides for the various IRI products amd guides to using the Data 
Tools Platform User Documentation (DTP) and Remote System 
Explorer (RSE) plugins. This also covers conventions used for IRI 
products, descriptions for the wizards, and troubleshooting problems.

• RSE User Guide - This covers connections to remote Windows, Linux, 
and Unix servers where licensed IRI executables are installed.

• Sirius

Overview

Links to an introduction for each product and describes the 
wizards and dialogs involved in the use of the product. 
Product documentation links are included on the Overview 
screen, as well as information about the Eclipse Data Tools 
Platform (DTP) that connects to and works with 
JDBC-compatible data sources.

Tutorials Links to Getting Started tutorials and Cheat Sheets for 
each IRI product.

First Steps

Provides links that guide you in the use IRI Workbench, 
including setting up the connections to your databases, 
through both Open Database Connectivity (ODBC) and Java 
Database Connectivity (JDBC), and cheat sheets that take 
you through the process of creating and starting jobs.

Samples Links to a cheat sheet that guides you through creating IRI 
projects and importing an example job script.



  

Installation Guide 35 Using IRI Workbench

In the top navigation toolbar you will also find icons for menus specific to each IRI 
product and for some of the utilities:

Debug - executes a sortcl-compatible job in debug mode. 
Previously run jobs can be selected from a list.

Run - executes a sortcl-compatible job. Previously run jobs can 
be selected from a list.

Run Last Tool - used to execute batch jobs and other tools. 
A previously run job can be selected from a list.

IRI - links to wizards common to multiple IRI products.

Voracity - links to wizards for creating new jobs for ETL, data 
consolidation, DB subsetting, pivoting tables, SCD (Slowly 
Changing Dimensions), and CDC (Change-Data-Capture).

CoSort - create sortcl job scripts or flows or add to an existing 
flow.

FACT - perform high-speed extractions from relational DB tables.

NextForm - create jobs that reformat and migrate data

FieldShield - create jobs that mask PII and other sensitive data.

RowGen - create a test data job, or a set file to be used with a 
test data job.

Discover - profile a database or flat file, build an ER diagram, 
classify data, train an ER model, or perform a new data class or 
schema pattern search.

DarkShield - find and mask sensitive data in unstructured files 
and NoSQL DBs, and recognize named entities. 
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Installing Third-Party CoSort Plug-ins

The table below shows the third-party software for which CoSort offers drop-in sort 
replacements. It also provides references to the sections in the CoSort User Manual 
that describe the initialization of each plug-in interface, when applicable.

Product CoSort User Manual Cross-Reference
ACUCOBOL-GT Contact your IRI representative

Amdocs Ensemble Contact your IRI representative

DataStage Contact your IRI representative

Informatica Contact your IRI representative

MF COBOL Net Express MF COBOL WORKBENCH 4.0 AND NETEXPRESS 2.X 
SORT REPLACEMENT FOR WINDOWS
MF COBOL Net Express SORT REPLACEMENT FOR 
WINDOWS

MF COBOL Server Express MF COBOL ServerExpress 2.2-4.0 SORT 
REPLACEMENT FOR Unix

MF COBOL Workbench for 
Unix

MF COBOL WORKBENCH 4.1 SORT REPLACEMENT 
FOR Unix

MF COBOL Workbench for 
Windows

MF COBOL WORKBENCH 4.0 AND NETEXPRESS 2.X 
SORT REPLACEMENT FOR WINDOWS

SAS USING COSORT WITH THE SAS SYSTEM

Software AG Natural USING COSORT WITH SOFTWARE AG NATURAL

Sun MRP (MTP/MBM) Contact your IRI representative

Unix /bin/sort The sort PROGRAM chapter
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Install NextForm on Windows with or without COBOL 

To install the COBOL version of NextForm Lite, follow the instructions at 
www.iri.com/nextform for downloading Nextform Lite. Also, download the file 
lmsetupx86.msi. A Micro Focus license is required and must be provided by your 
IRI representative.

If upgrading, remove the previous versions of NextForm before installing 
the newer version. To do this, uninstall the previous versions using the 
Add/Remove Programs facility in the Windows Control Panel, then 
manually remove any executables from previous versions, such as any 
locally-stored nextform.exe files.

Install NextForm on any Windows operating system

Loading

1. Run NextForm_full_install.exe. The install shield prepares for setup, and a 
splash screen displays.

2. When the welcome screen displays, click Next to continue. The Software 
License Agreement screen opens.

3. Read the license agreement. If you accept the terms, select the option I accept 
the terms in the license agreement, then click Next. 

4. On the Customer Information screen, enter your Name, Organization, and 
Serial Number (in the form xxxxx.xxxx) provided by your IRI representative. 
Click Next. The Destination Folder screen opens.

Installation and Registration

1. By default, NextForm installs into C:\IRI\NextForm, which is referred to as 
install_dir throughout this section. Click Change to provide a different location. 
When your destination directory is set, click Next. The Setup Type screen 
opens.

2. By default, the Full setup is selected to install the NextForm command line tools 
plus IRI Workbench. If you want to install the NextForm command line tools 
only, select Minimal, then click Next. Now the Ready to Install the Program 
screen opens.

3. If you are not satisfied with any of the details shown on this screen, click Back to 
return to previous screens. Otherwise, click Install. After the Nextform files are 
copied to your computer, the Installation Complete screen displays.

NOTE
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4. Click Finish. By default, Run the setup program is selected. You can select 
Show the readme file for details on product changes and enhancements since 
the prior version.

You can update the license even if a job is in progress. The new keys will 
be used in the next job to start up so long as the executable is in the same 
%NEXTFORM_HOME% environment.

License Key Activation

NextForm trial software is enabled for use without license keys, but drops records at 
random to prevent production use. To obtain permanent license keys:

1. Select NextForm Registration from the All Program Folder group you 
specified during installation. By default, you can access this from Start -->All 
Programs
-->NextForm.

The NextForm Registration screen opens with the following options available:

• Purchase Keys
• Enter Keys
• Exit

2. Select Purchase Keys. Complete all the relevant fields of the NextForm 
Customer Registration Form. This is required in order to obtain license keys.

3. Upon completion, click:

• OK to save a RegForm.txt file in the installation directory, then exit the 
NextForm Customer Registration Form.

• Save As to select the directory into which the RegForm.txt will be saved. 

• E-mail to open your default e-mail client with a copy of the completed 
registration form pasted to the body of the message. If your e-mail client does 
not open, use Save As.

E-mail the RegForm.txt to licenses@iri.com. Note that you can edit this form at 
any time after the setup process is complete.

4. Click OK to exit the registration form screen. Click Exit on the NextForm 
Registration screen to close.

5. Once you receive your license keys, return to NextForm Registration from 
Start-->All Programs-->NextForm. 

6. Select Enter Keys. Enter the three provided keys, then click OK. 

NOTE
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7. Select Exit to close the NextForm Registration screen. If the keys are invalid 
or have expired, an error message will appear.

The program folder NextForm is found in the Programs group of the Start menu. 
To verify that the NextForm license is in effect, and to run the product in 
command-line or script development mode, open a command-line window. Go to the 
install_dir\bin directory that was specified at installation, and type: 

nextform /v

 If there is no error status, you are ready to use NextForm.

COBOL Edition

To install Micro Focus License Manager on Windows:

1. Run lmsetupx86.msi. The Micro Focus License Manager Setup wizard 
opens.

2. Click Next. The End-User License Agreement screen opens. Read the license 
agreement and accept the terms by selecting that box, then click Next. The 
System Firewall screen opens.

3. Keep the check box selected to Unblock the systems firewall for the Sentinel 
RMS License Manager, and then click Next. The Ready to install Micro Focus 
License Manager screen opens. 

4. Click Install. The Micro Focus License Manager is installed. The Completed 
screen displays.

5. Click Finish.

To install the Micro Focus license:

1. Go to Start-->All Programs-->Micro Focus License Manager and select 
License Administration. The Micro Focus License Administration wizard 
opens.

2. Click the Install tab.

3. In the License file field, click Browse to locate and open the Micro Focus license 
file provided by your IRI representative.

4. Click Install Licenses. A message indicates if the license was successfully 
added.

5. Click the Summary tab to display the status of the Micro Focus license.

6. Select File-->Exit to close the Micro Focus License Administration wizard.



  

Installation Guide 40 Installing NextForm on Window

To add the path to the COBOL libraries used by Nextform:

1. Open the Windows Control Panel and select System.

2. Click Advanced system settings in the left navigation pane. The System 
Properties dialog opens.

3. Click Environment Variables near the bottom of the page. The Environment 
Variables dialog opens.

4. In the top window, select PATH, and then click Edit.

5. At the end of current path, enter: 

C:\Program Files (x86)\Micro Focus\COBOL Server\bin\

If you did not use the default path at installation, enter the correct path.

6. Click OK to close the edit window, then close any open dialogs. Setup is now 
complete.

The NextForm folder is found in the All Programs group of the Start menu. 

To verify that the NextForm license is in effect, and to run the product in command-
line mode, open a command-line window. Go to the install_dir\bin directory that 
was specified at installation, and type:

 nextform /v 

If there is no error status, you are ready to use NextForm.

License Key Activation

NextForm trial software is enabled for use without license keys, but drops records at 
random to prevent production use. To obtain permanent license keys:

1. Run the setup program and e-mail a complete RegForm.txt to licenses@iri.com 
to obtain permanent license keys.

2. Click Enter Keys. Enter the three keys, then click OK. 

3. Click Exit to close the NextForm Registration screen. If the keys are invalid or 
have expired, an error message will appear.
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Installing CellShield EE

Use the following steps to install and license IRI CellShield EE on Windows. Excel 
must already be installed because this product is an add-in to Microsoft Excel. 
However, its operation requires the installation of IRI Workbench either with or 
without CoSort installed and an update for Workbench that adds the Dark Data 
Discovery feature

Downloading

Click on the link in your e-mail. A web page displays where you fill in your first name, 
last name, and e-mail address. After checking the "I agree to the terms of our NDA", 
click Download. Execute the installer by double-clicking on the downloaded file (for 
example CellShieldEE.x86_32.install.exe). The following screen will display:

Click Next.

You can choose to print the License Agreement. After selecting "I accept the terms in 
the license agreement", select Next.

The following screen displays the install information:
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It is required that your Destination Folder be C:\IRI\CellShield. Select Install. 
The below screen will display while the program files are being installed:
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Then click Finish on the screen below.

Activating a License

Open a spreadsheet in Excel and click CellShield on the top tool bar to display the 
ribbon icons. Click on one of the Data Protection functions, such as Encrypt & 
Decrypt. Select one of the menu items. Since this is your first time using CellShield, 
you will get the following pop-up:

Click the Purchase Page button. This takes you to the IRI "Purchase CellShield" web 
page. It is not necessary to fill out the items on this page, but you need to send the 
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Setup Key to licenses@iri.com. IRI will then send you three license keys that are 
concatenated with a period between each.

Open your Excel and go through the same steps to bring up the Purchase License 
pop-up. Copy the license key string into the box and select Ok. The original menu 
item that you selected will now come up. You can continue with that item or select 
Cancel.

Your CellShield license is now active.
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Installing FACT

The following steps are used to install and license FACT (Fast Extract) on Unix, 
Linux, and Windows. When the database software is Oracle, be sure that the bit 
architecture of FACT matches that of your Oracle OCI libraries.

Loading

1. Download and unpack the tar.gz or .zip file provided by your IRI representative.

2. Create an environment variable called FACT_HOME, and set it to the FACT root 
directory created in step 1. This contains the /etc and /example sub-directories, 
and also holds the fact and factmgr executables.

Installation and Registration

3. From the $FACT_HOME directory, enter:  fact --trylicense

Follow the prompts and complete all entries to build the registration form. This is 
required to obtain license keys.

4. The file, RegForm.txt, is created in the $FACT_HOME/etc directory.

5. E-mail the file RegForm.txt to fact@iri.com. You will then receive a license key 
or set of keys via e-mail.

License Key Activation

6. Type fact --setlicense and enter the license keys at the prompt. You must 
then set up the required environment variables before you can use FACT. See 
"Preparing FACT for Use" in the FACT User Manual.

7. Type fact -v to verify that you have a valid license. See "Fact Execution" in the 
FACT User Manual.
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We Need Your Input

IRI, Inc. upholds a standard of documentation quality that is can be
maintained through proactive user feedback. If you have any comments, 
concerns, or suggestions regarding this documentation, please let us 
know.

Please indicate the title and page numbers in the manual you are 
addressing. Be sure to provide your name, address (or email address), 
and telephone number if you would like a reply from IRI.

Mailing address: Technical Publications
INNOVATIVE ROUTINES INTERNATIONAL, INC.
2194 Highway A1A, Suite 303
Melbourne, FL 32937-4932
USA

Telephone: USA +1 (321) 777-8889

Fax: USA +1 (321) 777-8886

E-Mail: support@iri.com

The comments you provide may be used by IRI to improve the quality of, 
or to make additions to both documentation software.

Additional suggestions or submissions may be made or posted through 
the technical support area at https://www.iri.com/support.

© 1978-2026 IRI, Inc. All rights reserved. No part of this document or 
the CoSort programs may be used or copied without the express written 
permission of IRI.

http://www.iri.com
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